Introduction to RH Linux

Web resources:


RH Linux Home Site:  http://www.redhat.com
RH Linux Documentation (requires user account login) 
                                      http://www.redhat.com/docs/manuals/linux/RHL-9-Manual/getting-started-guide/


Google Linux Search Page: http://www.google.com/linux

Google Directory of Linux Links: http://directory.google.com/Top/Computers/Software/Operating_Systems/Linux/Support/Tutorials/

Sourceforge.net Linux drivers http://linuxdrivers.foundries.sourceforge.net/
Sourceforge.net Linux kernel http://linuxkernel.foundries.sourceforge.net/
Xfree86 Site (video configuration files) http://xfree86.org/


Linux help and tutorials  http://www.linux.com/
Linux shell commands: http://www.groovyweb.uklinux.net/?page_name=unixcommands
Find RPM packages foir Linux http://rpmfind.net/
Gnome Ximian Desktop Tutorial http://linux.oreillynet.com/pub/a/linux/2001/02/16/ximian.html?page=1
Eric Raymond's “The Cathedral and the Bazaar”

http://www.firstmonday.dk/issues/issue3_3/raymond/

Useful Beginner Linux books:

“Teach Yourself Redhat Linux 8 / 9  in 24 Hours”  Aaron Hsaio, SAMS
”Learning Redhat Linux”   Bill McCarty, OReilly

Why Use Linux?

“Linux is a multitasking, multiuser operating system, which means that many people can run many different applications on one computer at the same time.  This differs from MS-DOS, [and most versions of Windows], where only one person can use the system at any one time.  To identify yourself to the system, you must log in, which entails entering your login name (the name the system uses to identify you), and entering your password, which is your personal key foir logging into your account. Because only you know your password, no one else can log in to the system under your username.

In addition, each system has a host name assigned to it.  It is this host name that gives your machine a name, gives it character and charm.  The host name is used to identify individual machines on a network, but even if your machine isn't networked, it should have a host name.”

See Jang, chapter 1, p.3-6


Read Eric Raymond's “The Cathedral and the Bazaar”

http://www.firstmonday.dk/issues/issue3_3/raymond/

Linux RH 9 System Requirements:

See Jang, chapter 1, p. 5-6


CPU:  Pentium Class (PII 400 recommended as minimum to run GUI-interface)

HD DISK: minimum of 475MB   (5000 MB installs all packages, 3000MB will probably be enough for exercises in this class)

RAM: 128MB for Graphic Workstation (192MB recommended)  Using only 64MB may result in sluggish performance.

Making Linux Installation CDs in Class:


1. Install CD Burner software on Windows 2000 Pro machines.

log onto Windows 2000 Pro   user: administrator password:  [blank]

2. Go to My Network Places -> View Entire Network->Microsoft Windows Network->Workgroup
Open Instructor Computer.
Open Instructor Folder.
Copy NTI CDMaker Platinum Folder to drive C of your local computer


3. Install NTI CDMaker, then restart computer.


4. Open Windows server with Linux ISO files:
Server name:  \\server2003\RedHat9 ISO Images
Login:  linux_user  password:  password


5. Right-click on RedHat9 ISO Images folder and map it to a network drive.

6. Open the NTI CDMaker program and insert a blank CD-R into the CD-ROM drive.

7. Choose Data -> Data CD icon

8. Choose File -> Create Disc from ISO Disc Image File

9. Leave Default settings, click Start

Installing Linux

Set computer to boot from CD-ROM drive by accessing CMOS

Insert RH Linux 9 Setup Disc 1

Follow Installation Prompts:

Options:  Check  media integrity (skip)

See Jang, Chapter 3, p. 50

Selecting Installation Prompt Optons

Configuring Basic Parameters

Setting Up Hard Drives

Configuring Installation Details

Selecting Package Groups

Managing Post Installation Steps

Install screens


Welcome to Red Hat Linux – (Hardware Requirements in release notes)

Language Selection

Keyboard Configuration

Mouse Configuration  (choose 2-button PS/2)

Upgrade Examine

Installation Type  (choose Workstation)

Disk Partitioning Setup

Manually Partition with Disk Druid

In free space, choose new (mount at /); type: ext3; size: 5000;  
(choose “Continue”; notice checkmark on partition screen)

In free space, choose new; type: swap; size: 500
 (Swap partition is required, size should be at least equal to installed RAM)

In free space, choose new, type: /vfat  mount point: /usr/local; size: 2000
(this will be a FAT16 partition visible under both Windows XP and Linux) 

Boot Loader Configuration   (Leave RH Linux device: /dev/hda2 as default) leave other defaults.

Network Configuation   (Accept defaults)

Firewall  (Accept defaults  *only because we already have a network-wide firewall)

Additional Language Support/Time Zone Selection  (Los Angeles)

User Accounts:  Root password: passw0rd    (the “0” is a zero)

Workstation Defaults (Package Information)


Choose “Customize set of packages to be installed”
Add:  KDE Desktop Environment; Server Configuration Tools; Web Server; Windows File Server; SQL database server, Kernel Development (*important); System Tools 

Boot Disk Configuration (create boot floppy if you have one)

Graphical Interface (Accept defaults)

Monitor Configuration (Test)

Create a regular user:   Username: studentn (where n is your number)  Password: passw0rd

Date and Time

Sound Card

Register with Red Hat Network  (we’ll register after we create e-mail accounts)
Basic RH Linux Activities

Linux Login

Two methods: GUI and command line

See RH Linux 9 Getting Started Guide:

http://www.redhat.com/docs/manuals/linux/RHL-9-Manual/getting-started-guide/

1.3.1. Graphical Login

When your system has booted, a graphical login screen is displayed as shown in Figure 1-8. Again, unless you have chosen to give your machine its own hostname, which is primarily used in a network setting, your machine will probably be called localhost. 

Figure 1-8. The Graphical Login Screen

To log in as root from the graphical login screen, type root at the login prompt, press , type the root password that you chose during installation at the password prompt, and press . To log in as a normal user, type your username at the login prompt, press , type your password that you selected when creating the user at the password prompt, and press . 

Logging in from the graphical login screen automatically starts the graphical desktop for you. 

· 1.3.2. Virtual Console Login

During installation, if you selected an installation type other than Workstation or Personal Desktop and chose text as your login type, you will see a login prompt similar to the following after booting your system: 

	Red Hat Linux release 9

Kernel 2.4.18-14 on an i686

localhost login:


Unless you have chosen to give your machine its own hostname, which is primarily used in a network setting, your machine will probably be called localhost.localdomain. 1.4. Graphical Interface

When you installed Red Hat Linux you had the opportunity to install a graphical environment. Once you start the X Window System, you will find a graphical interface known as a desktop similar to Figure 1-9. 

The Graphical Desktop

The graphical desktop gives you access to the applications and system settings on your computer. You will notice that it offers three main tools to make use of the applications on your system: panel icons, desktop icons, and menus. 

The long bar across the bottom of the desktop is the panel. The panel contains application launcher icons, a notification area for notification icons, and small applications called applets that let you control sound volume, switch workspaces, and displays the status of your system. 

The icons elsewhere on the desktop can be shortcuts to file folders, application launchers, and shortcuts to removable devices such as CD-ROM and diskettes when they have been mounted. To open a folder or launch an application, double-click on its icon. 

The menu systems can be found by clicking on the Main Menu button  . They can also be found by double-clicking on the Start Here icon  on the desktop and then clicking the Applications icon. 

The desktop works in the manner you might expect it to when working with other operating systems. You can drag and drop files and application icons to areas that are easily accessible. You can add new icons for files and applications to the desktop, panel, and file manager. You can change the appearance of most of the tools and applications and change system settings with provided configuration tools. 

Activities for Working with Files on Desktop

· create a new text file with text editor (gedit), use file dialog box to save

· open a file manager window displaying the files in your home directory

· open an existing file with the GUI file manager, edit it and save changes.

· Navigate within a file manager window to other directories in the Linux file system

· Use file manager to copy or move a file from one directory to another

· change the file permissions using the file manager

use the right-click context menu to perform common file management tasks.

· Reading and saving files to mounted DOS/Windows floppy drive (mnt\floppy)

Additional activities

Create directories and symbolic links

duplicate existing files or directories

delete files, directories, and symbolic links

Restoring Files from Trash and Emptying Trash

Activities for Using Open Office  (similar to MS Office)

Launch Open Office applications

Create a new document in Open Office Writer

Control basic formatting and layout in Open Office Writer

Create a new spreadsheet in Open Office Calc.

Perform simple formula calculations in Open Office Calc.

Activities for Networking on the Desktop

RH Linux Notes

Notes on Contents of Teach Yourself RH Linux 8

Hour 1:  Preparing to install

Hardware inventory:  memory capacity  (check CMOS startup); 

                                   CPU (check CMOS); 

                                   Hard Drive

                                   Communications (serial, pure modems, 

                                    (no winmodems, see http://linmodems.org
Suggested Sys Req:   

           CPU: Celeron, Pentium, K6, Duron, Athlon 300Mhz or faster  (not 386/486 with this distro)

           Memory: 128MB

           Hard disk: 2GB  (5 to 10GB is ideal)

           Ethernet or modem connection to the Internet

Partitioning:  Delete Windows partition (NTFS) or shrink (FAT16/32) with FIPS. Defragment first

*Copy files from /dosutils/fips20 folder on RH Linux CD 1, FIPS20.ZIP, (see readme file)

(

Non-CD install

User can create Linux bootdisk from Windows with rawrite \images\boot.img

                                                                                                 \images\drvblock.img
                                                         (for laptops)               \images\pcmcia.img and \images\pcmciaadd.img

Hour 2 Installation steps

Can access release notes or help 


Language Selection

Keyboard Configuration

Mouse Configuration

Installation types: Personal Desktop, Workstation, Server, Custom, Upgrade Existing System

Disk partitioning:  Automatic or Manual with Druid  (RH requires EXT3 and SWAP partitions.  EXT3 must be mounted at /    (boot information is stored in /boot directory, which may be separate partition.

RH9 also gives you the opportunity to create a boot loader partition to boot more than one OS or more than one Linux kernel version.  (You can pick the default OS on the boot loader menu.  (Best practice: install Windows first if you want to create a multiboot system.)

Network configuration:  DHCP or fixed IP (with Gateway, DNS server, hostname)

**Be sure to enable the built-in firewall option, unless your network already has adequate firewall protection.

Timezone

Account Configuration:  enter password for root and create user account

Packages:  automatic or manual

Graphic configuration:  ttry automatic configuration first, and test it.  Later on, you can run a command line X setup utility called XF86Config.

RH9 has two graphic interfaces, gnome (easier to use) and KDE (more powerful and adjustable).

Hour 3:  Booting, Logging In and Configuring

Update agent allows you to register with Redhat

Login screen includes language, session and system buttons  (Session letes you specify GUI environment).

System lets you shut down

Printing under System Setetings allows a printer to be installed

(select device such as /dev/lp0 or lp1, or /dev/usb/lp0); next screen specifies printer driver

Internet Configuration Wizard under System Tools allows you to set up a modem.

Hour 4:  Navigating Linux at the Console

tasks

switch between desktop display and virtual consoles

You need to learn to use linux at the console (keyboard and terminal)

  In linux several sessions can be active at the same time.

To switch to a virtual console, press CTRL+ALT plus a function key (the graphic terminal is usually CTRL+ALT+F7)

enter username and password

The linux shell is the command interpreter

default shell is bash.  (Others available include tcsh, ksh (korn), zsh)

to change a shell, enter chsh  with location /bin/shellname

default shell for user is stored in /etc/password  (env command lists user environment)

use basic terminology common to Linux and unix

in Windows, storage devices are assigned drive letters.  Linux has one filesystem and one root.

Storage devices are accessed by mounting devices to specific directory paths

ls command is analogous to DIR command

each user has a home directory

current directory is shown at the prompt

enter commands at the console

use basic commands for file and directory manipulation

ls  -- list files & directories

pwd shows current directory

cd changes directory

cp  sourcefile targetfile copies files

mv sourcepath targetpath moves files

rm filename removes a file

rmdir removes a directory

“relative path” is subdirectory that doesn't begin with root (/)

executable files are stored in /bin and /sbin (for superuser)

(usually coded in green)

symbolic links are coded in cyan

ln creates a symbolic link  (ln -s  sourcename targetname)

understand file permissions and file system security

each file and folder has a set of security permissions (r=read, w=write, x=execute) for the owner, group and other users.

Chmod, which changes permissions can be used in two modes, symbolic mode and numeric mode

symbolic:  chmod permcode (u|g|o)  access  (+/- r,w. or x) filename 

examples:  chmod o -r filename

                 chmod g -rw filename 

numeric mode

(The default numerical values assigned in Chmod are r=4, w=2, execute=1)

example: chmod 555 filename assigns the following permissions to filename (+w +x =5)

filename  r-x r-x r-x

Hour 5:  Making the Console Work For You

Create, edit and save text files in home directory

(use gedit instead of vi (possibly use emacs)

manage groups of similar files

create directories for similar files

(ls parameters: *=wildcard, ?=single char wildcard, a-z(match single char) abc (match char in list)

find command can search directory tree  (find - -name textstring)  “~” designates home directory

*filenames are case specific in Linux

locate searches entire directory structure

save search (such as “locate '*.jpg' >jpegs.txt”

grep searches textfiles for words or patterns:

example:  grep dell XF86config

                 grep -l Unix *    lists all files that contain the word Unix

use std output path to save info in text files or link commands

example:  make a folder to contain symbolic links to all jpeg files on the system

              mkdir jpegfiles

                ln -s $(locate '*.jpg') jpegfiles

== 

ln creates  hard and symbolic links.

A hard link is a link made at inode level, that is at a filesystem level. You can only hard link files of the same filesystem.

A symbolic link is just another file which content is just the path to the "original" file. It can be on another filesystem (and on another computer if it is imported via nfs....) If the source file is removed, the link is broken....

See also http://www.itworld.com/nl/unix_sys_adm/06062001/

===

command substitution can be implemented by $ sign (as above) or by including substitute command in backquotes.

locate files in directory tree by filename or content

redirect output of one command to another

start and stop jobs without exiting program

Ctrl+Z suspends activity in  an applicationto see a list of jobs, use jobs commandsto resume working, use command fg %1, where %1 is shell job number.

Bg performs job in the background.


Hour 6:  Getting Help at the Console

find online manual pages for console commands

Ask for list of useful commands and manual pages

search through online text documentation

list and save help messages generated by commands and applications

- 

Man and apropos

Type Man followed by command or services

    man command uses pager (called “less”)

spacebar:  goes to next page

b:  goes back to previous page

/ “text” searches for text strings in particular man page

q: quits man display

man entries are divided into sections

User commands

System Calls

Subroutines

Devices

File Formats

Games

Miscellaneous

Administration

Local

New

to read manual pages for all sections use:  man -a

sections are accessed by number:  example:  Man -5 reads from File Formats (section 5)

apropos [subject] may reveal additional information about specific commands:

Example:  apropos directories  or 

“info” is an alternate information system inherited from gnu  (type info [subject]

Documentation is located in /usr/share/doc tree

To read a document, cd to apopropriate directory and enter more [filename]

Meta document organization:

README -- release specific information

BUGS – list of known bugs

CHANGES – changes since last release

TODO – features to be implemented in the future

COPYING – copy of software distribution license for application

AUTHORS --- list of code contributors

NEWS – announcements and release information related to application

*Search the /usr/share/doc tree with find and grep

Hour 7:  Working without the mouse

 format floppy disks for Windows or DOS and copy data to them:

Hour 10:  The Red Hat Desktop

login screen permits login to either gnome or KDE

screen includes taskbar, application launchers, gnome menu, desktop icons

Red Hat is Gnome menu button (like Windows start menu)

World icon is Mosiac web browser

Envelope and Stamp is Ximian Evolution Email Client

Paper and Pen is Open Office.org Writer (similar to MS Word)

Slide show icon is Open Office Presentation applet (similar to PowerPoint)

Chart icon is the Open Office Calc Spreadsheet program

“Four squares permit switching between “virtual desktops”
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Taskbar area displays minimized windows as in Windows

     right-click and you can install new panels (toolbars) or add apps to existing apps

Gnome Menu permits you to  launch applications

   examples:  Accessories – text editor, Internet – alternate browsers and email

                      Preferences – similar to Windows Control Panel, Sound and Video – volume control, system settings, system tools

*What if “Search for files” applet doesn't work?    (run Terminal, enter “locate -u)

Hour 11 – Working with Files on the Desktop

create new text file with text editor

open file manager window and display home directory

open existing file from file manager, edit and save changes

navigate with file manager window to other directories in Linux file system

Description of file manager window

RH 8 and 9 use the Nautilus File Manager, below is the version in RH 8.  The RH9 version is similar.

	

	
	As shown in Figure 6-6, the left file manager pane presents a hierarchical directory tree whereas the right pane shows the contents of the directory currently selected in the left pane. To select a directory, simply left click it.
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	Figure 6-6.
The file manager
	
	
	

	
	
	
	
	

	
	
	
	
	

	

	
	
	
	
	

	
	
	
	
	

	
	
	
	The right pane can show an icon for each file or detailed information about each file, as shown in Figure 6-7. To switch from icon to detailed mode, left click the proper button on the file manager toolbar. You can also select custom mode, which lets you tailor the display appearance according to your own taste.
	
	
	

	
	
	
	
	

	
	
	
	
	

	

	
	
	
	
	

	
	
	
	
	

	
	
	
	Like the Windows Explorer, the file manager can copy, move, rename, and delete files. To perform one of these operations, you must first select the file or files you want to copy, move, rename, or delete. You can select a single file by left clicking in the right file manager pane. To select additional files, hold down the Ctrl key as you select them. Alternatively, you can click and drag the cursor around a group of files. The Edit menu provides additional ways of selecting files.
	
	
	

	
	
	
	
	

	
	
	
	
	

	

	
	
	
	
	

	
	
	
	
	

	
	
	
	To move a file, simply drag it to its new location. To copy a file, hold down Shift while dragging it. Alternatively, you can right click on a file and use the pop-up menu to specify the action you want to perform. The file manager then displays a dialog box that lets you specify additional options.
	
	
	

	
	
	
	
	

	
	
	
	
	

	


	To rename a file, right click on the file and select Properties from the pop-up menu. Simply type the new name in the File Name field and click on OK.
	
	

	

	


	
	
	

	
	
	

	
	
	To delete a file, right click on the file and select “Move to Trash” from the pop-up menu. A dialog box asks you to confirm your decision.
	
	

	
	
	

	
	
	


	
	
	

	
	
	
	

	
	
	

	
	
	
	
	

	
	
	

	
	
	


	
	
	

	
	
	

	
	
	
	
	

	
	
	
	

	
	
	

	
	
	


	
	
	

	
	
	

	
	
	The file manager lets you double click on a file to launch the application associated with the file. Alternatively, you can right click on the file and select Open With from the pop-up menu. GNOME launches a dialog box that lets you specify the application that should be launched.
	
	

	
	
	

	
	
	


	
	
	

	
	
	

	
	
	Many applications are GNOME compliant, supporting drag and drop operations like those supported by Windows 9x. For example, you can open two file manager windows and drag and drop files or directories between them.
	
	


Exercises:

Use Back Button, Forward Bautton, Up Button, Zoom In/Out, History/Information/Notes/Tree

Go to root directory

double-click “Home” icon

double-click files or folders to display, run, or open

Right-click context menu allows files and folders to be cut/copied and pasted.

**KDE shell uses the Konqueror file manager and web browser by default

Network stuff from RH8 Unleashed

examine interface with modprobe devname

ifconfig <device> up | down turns on and off

route shows standard routes  (route -n subs ip addreses for names

route add allows host or  network route to be added.

Configuration filkes:

/etc/hosts   lists addresses, hostnames, and aliases  (as in W2K)

                                                      ipadr    domain name    shortname

/etc/services    lists network services and port connections

/etc/nsswitch.conf   linux network information service configuration

/etc/resolv.conf    DNS search settings

/etc/host.conf   network information serch order

/etc/sysconfig/network   hostname, IP address, boot activation control, gateway

dhcpd.conf contains dhcp settings

services started/stopped through /etc/rc.d/init.d/    (ex: nfs start)   
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